
Programmeermethoden

MATLAB, Java, Qt, . . .

week 14: 12–16 december 2011

http://www.liacs.nl/home/kosters/pm/

www.mathworks.nl/products/matlab,

java.sun.com/ en qt.nokia.com/
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Talen Algemeen

De laatste jaren wordt —naast C++— ook veel gebruik

gemaakt van Java, Python en MATLAB. En Qt voor in-

terfaces. We kijken straks kort naar Java en Qt.

MATLAB, zelf in C geschreven, is met name goed in allerlei

wiskundige operaties: matrices, . . . ; de taal heeft ook veel

grafische mogelijkheden: plotten, . . .

Nadeel: MATLAB is duur.

Naast de workspace heb je de “command history” en de

“command window”.

Programma’s (scripts) hebben extensie .m.

2



MATLAB Visueel
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MATLAB De taal

MATLAB is een “weakly dynamically typed” taal. Na

>> A = ’abc’;

is A een string, en na

>> A = [10 20 30; 7 8 9];

wordt A dan een 2 × 3 array.

Als je de punt-komma aan het eind weglaat, krijg je geen

uitvoer in het commando-venster voor deze regel. Dus:

>> A(2,1)

ans =

7
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MATLAB Plotten

Stel je wilt de sinus plotten:

>> x = 0:pi/100:2*pi;

>> y = sin(x);

>> plot(x,y)

Je kunt namelijk een vector (een 1-dimensionaal array) ma-

ken met

>> array = 1:2:9

array =

1 3 5 7 9

waarbij “initialisatie:stapgrootte:terminator” gebruikt wordt.
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Java Introductie

De programmeertaal Java lijkt veel op C++.

Enkele belangrijke verschillen:

• Java is (nog) meer object-georienteerd

• Java heeft automatische garbage collection

• Java heeft (bijna) geen pointers

• Java is platform-onafhankelijk

• Java kent applets: WWW-applicaties, met GUI’s
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Java Compileren

Hoe compileer je een Java-programma, dat in Iets.java

staat? Met javac *.java compileer je al je Java-files naar

bytecode, in ons geval naar Iets.class. Deze kan met

java Iets op elke computer gedraaid (om precies te zijn:

geinterpreteerd) worden met behulp van de Java Virtu-

al Machine (JVM). Dit bovenstaande geldt voor “tekst-

applicaties”.

Een applet wordt bekeken met een webbrowser, en je moet

dan een aparte HTML-pagina naam.html maken die de byte-

code aanroept. Rechtstreeks (zonder browser) kan vaak

ook eenvoudig met appletviewer naam.html, zie later.

Overigens, Java is iets heel anders dan JavaScript.
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Java Hello world

Maak een file Hello.java met

public class Hello {

public static void main (String[ ] argv) {

System.out.println ("Hello world!");

}//main

}//class Hello

En dan javac Hello.java en java Hello.

Let op: filenaam = naam public klasse (met hoofdletter).

Er kunnen meer klasses in een file staan, maar er is er maar

één public, en bij diens public static void main begint de

executie van het programma.
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Java Schermuitvoer

Met

int x = 10, y = 20;

System.out.print (x + y);

System.out.println (" of toch: " + x + y);

krijg je 30 of toch: 1020, gevolgd door een regelovergang,

op het beeldscherm te zien,

Pas dus op met type-conversies.
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Java Faculteit — 1

En nu een programma Fac.java, met een wat ingewikkelder

klasse met twee methodes (member-functies):

public class Fac {

private static int facul (int n) {

if ( n == 0 ) return 1;

else return n * facul (n-1);

}//facul

public static void main (String[ ] argv) {

int m = 5;

System.out.println (m + "! is " + facul (m));

}//main

}//class Fac

Let op het woordje static bij de functie-definitie: de functie

mag dan aangeroepen worden zonder dat er een object van

die klasse is.
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Java Faculteit — 2

En iets aangepast in Fac2.java:

public class Fac2 {

private int facul (int n) {

if ( n == 0 ) return 1;

else return n * facul (n-1);

}//facul

public static void main (String[ ] argv) {

int m = 5;

Fac2 prog = new Fac2 ( );

System.out.println (m + "! is " + prog.facul (m));

}//main

}//class Fac2

Nu maken we met new een object prog van onze klasse Fac2,

waarna we van dat object de methode facul (nu niet meer

static) aanroepen. Er is geen delete nodig!
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Java Variabelen

Variabelen worden in Java altijd “call-by-value” doorgege-

ven. In het bijzonder geldt dit voor int’s, double’s, char’s

en boolean’s (in C++ bool’s geheten).

In geval van klassen wordt er eigenlijk een pointer doorge-

geven — maar dat “weet niemand”. Het object waar naar

gewezen wordt kan dus wel veranderen! De speciale waarde

null wijst naar niks.

Er zijn automatische initialisaties.
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Java Arrays

Java kent uiteraard ook arrays. Deze moeten voor gebruik

altijd ge-new-ed worden:

double A[ ] = new double[25]; // A[0],A[1],...,A[24]

int B[ ][ ] = new int[4][3]; // 2-dimensionaal array B

Let er op dat de notatie soms net iets van die van C++

verschilt. Zo mag double [ ] A = new double[25]; ook.

In bovenstaand voorbeeld is A.length gelijk aan 25, de leng-

te van het array. Dus er is geen extra functie-parameter

nodig om de array-lengte door te geven.
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Java Strings

Een functie die een string omkeert:

public static String keerStringOm (String origineel) {

char [ ] temp = origineel.toCharArray ( );

// converteer originele string naar char-array

// er wordt "vanzelf" ge-new-ed!

for ( int i = 0; i < temp.length/2; i++ ) {

char waarde = temp[i];

temp[i] = temp[temp.length-i-1];

temp[temp.length-i-1] = waarde; }//for

return new String (temp);

}//keerStringOm

Deze functie geeft dus eigenlijk een pointer naar een nieuwe

string terug. Geen zorgen om delete’s!
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Java Lijsten

Hoe gaan pointerlijsten dan in Java — je hebt toch geen

pointers!?

In C++:

class Vakje { public: int info; Vakje* volgende; };

...

Vakje* p; p = new Vakje; p->info = 37;

In Java:

class Vakje { public int info; public Vakje volgende; }

...

Vakje p; p = new Vakje; p.info = 37;
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Java Exceptions

Als er tijdens het draaien een fout optreedt, wordt er soms

een exception gegenereerd. Die kun je “opvangen”:

try {

...

i = doeiets (i);

A[i] = 42;

...

} catch (IndexOutOfBoundsException ex) {

System.out.println ("Foutje ... " + ex);

}//catch

Als zo’n exception nergens (ook niet in aanroepende func-

ties) wordt opgevangen, stopt het programma.
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Java Input

Input in Java is iets ingewikkelder georganiseerd:

import java.io.*;

// net als #include <iostream> in C++

try {

String inputString; int waarde;

BufferedReader BR; // net als cin in C++

BR = new BufferedReader (

new InputStreamReader (System.in));

inputString = BR.readLine ( );

waarde = Integer.parseInt (inputString);

System.out.println (waarde * waarde);

BR.close ( );

} catch (Exception ex) {

System.out.println (ex); }//catch
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Java Input uit file

Input uit een file gaat ongeveer net zo:

BR = new BufferedReader (

new FileReader ("mijnbestand.txt"));

Dit is bedoeld om char’s mee in te lezen. Er zijn diverse

varianten.

En een outputfile (een van de mogelijkheden):

PW = new PrintWriter (

new OutputStreamWriter(

new FileOutputStream ("eenfile.txt")));
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Java Applet — 1

In een internet-pagina kun je eenvoudig een Java-program-

ma opnemen, met een fraaie grafische user interface (GUI).

We maken dan een applet.

Eerst wat HTML, in (zeg) naam.html:

<HTML><TITLE>Test123</TITLE><BODY>

<APPLET CODE="MyApplet.class" WIDTH=400 HEIGHT=200>

<PARAM NAME="buttonName" VALUE="Klik hier">

</APPLET>

</BODY></HTML>

Bekijken met appletviewer naam.html of via een browser.

Met Swing heb je talloze mogelijkheden . . .
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Java Applet — 2

import java.awt.*; // "event-driven" programmeren
import java.awt.event.*;
import javax.swing.*;
import java.applet.*;

public class MyApplet extends JApplet implements ActionListener {
private JButton myButton; // applet met een knop
public void init ( ) {

Container contentPane = getContentPane ( );
contentPane.setLayout (null);
myButton = new JButton (getParameter ("buttonName"));
myButton.setBounds (10,10,100,50);
myButton.addActionListener (this);
contentPane.add (myButton);

}//init
public void actionPerformed (ActionEvent evt){

Object source = evt.getSource ( );
if ( source == myButton ) // waar komt event vandaan?

myButton.setText ("Geklikt ...");
}//actionPerformed

}//class MyApplet
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Java Applet — 3

http://www.liacs.nl/home/kosters/java/muis.html
http://www.liacs.nl/home/kosters/java/sleep.html
import java.awt.*; import java.applet.*; import java.awt.event.*;
public class Muis5 extends Applet

implements MouseListener, MouseMotionListener {
public int teller = 0;
public void init ( ) {

addMouseListener (this); addMouseMotionListener (this); }//init
public void paint (Graphics g) {

g.setColor(Color.white); g.fillRect(10,10,500,500); }//paint
public void mouseClicked (MouseEvent event) { }//mouseClicked
public void mouseReleased (MouseEvent event) { }//mouseReleased
public void mousePressed (MouseEvent event) { }//mousePressed
public void mouseEntered (MouseEvent event) { }//mouseEntered
public void mouseExited (MouseEvent event) { }//mouseExited
public void mouseDragged (MouseEvent event) {

Graphics g = getGraphics ( ); teller++;
switch ( teller % 4 ) {

case 0: g.setColor (Color.red); break;
case 1: g.setColor (Color.green); break;
case 2: g.setColor (Color.black); break;
case 3: g.setColor (Color.blue); break; }//switch

g.drawLine (event.getX ( ),event.getY ( ),
event.getX ( )+10,event.getY ( )+10); }//mouseDragged

public void mouseMoved (MouseEvent event) { }//mouseMoved
}//Muis
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Java-Qt Event-gestuurd

Wat we hier —en straks ook in Qt— zien is dat de “control-

flow” event-driven (event-gestuurd) is. En dat is anders

dan wat we gewend zijn!

Een onzichtbare hoofdloop (de “event-lus”) loopt “einde-

loos” door. Intussen worden, door events zoals muis-acties

af te handelen, de gebruikerswensen vervuld. Dat zijn pre-

cies methoden (= memberfuncties) behorend bij bepaalde

objecten.
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Qt Introductie

Qt (“cute” of “ku-tee”; de ’t’ is van toolkit) is een door

Nokia (voorheen Trolltech) gemaakte “cross-platform ont-

wikkelomgeving”, met een ingebouwde C++-bibliotheek.

Samenwerken met Java kan ook. Voor niet commercieel

gebruik is het gratis.

KDE is erin geschreven — en Google Earth, Skype, . . .

Qt werkt met signals en slots. Als je iets doet, geeft je een

signal, dat ergens door een slot wordt opgevangen.
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Qt Tutorial

Hoe leer je Qt? Of Qt Designer?

Ga naar een Linux-systeem, bijvoorbeeld in zaal 302/304 of

306/308, en start in KDE op. Geef in een terminal-window

het commando designer & om Qt Designer te starten.
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Qt Oefening

Maak vervolgens een mooie GUI (Grafische User Interface)

voor Boter, kaas en eieren. Gebruik daarbij de C++-code

in boter.cc die hier te vinden is:

http://www.liacs.nl/home/kosters/pm/qt.php
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Qt Handleiding Qt

http://www.liacs.nl/home/kosters/pm/qt.php

Qt

We zullen hier kort proberen uit te leggen hoe je met Qt ("cute" of "Q-T", http://qt.nokia.com/) een mooie

gebruikers-interface v oor het spelletje Boter, kaas en eieren kunt maken. Het werkt onder KDE, ook wel

onder GNOME, op de Mac, en onder Windows. KDE zelf is met behulp v an Qt gemaakt. Er zijn v ele v ersies

v an Qt in omloop; in het onderstaande is op een tweetal plekken onderscheid tussen Linux en Windows.

Qt is een gigantisch pakket, het ev entueel installeren kost dan ook aardig wat tijd.

We doen drie stappen: eerst maken we de interface, daarna bouwen we het C++-programma dat Boter,

kaas en eieren speelt, en tot slot combineren we dit tot een fraai programma.

Stap 1

We zullen met behulp v an Qt Designer/Creator een mooie gebruikers-interface (GUI) maken. Begin in een

lege directory bke .

Linux-v ersie

Op de computers in zaal 302/304 is Qt al geinstalleerd. Er zijn v ia internet ook gratis v ersies v oor Linux

op te halen.

Start Qt Designer met designer & . Creëer een nieuwe "Form" v an type "Widget", die BKEForm  moet

gaan heten (bij  objectName ).

Windows-v ersie

Installeer onder de LPGL open source licentie v an http://qt.nokia.com/downloads, op de eigen PC, "Qt SDK

for Windows* (322 MB)". Het uitpakken v an de file qt-sdk-win-opensource-2010.05.exe  (v ersie

nov ember 2010) lev ert 1.6 GB aan software op! Er wordt onder meer een complete C++-compiler

meegelev erd: MinGW.

Start Qt Creator door op de Qt-ikoon te klikken. Kies File->New File or Project, en selecteer bij  Projects nu
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Qt (links), Qt Designer Form (rechts). Kies daarna Widget, en als filenaam bke.ui  in directory bke . Noem

de "Form" BKEForm  (bij  objectName ).

We gaan v oor beide systemen als v olgt v erder. In deze stap maken we alleen de interface.

De interface moet bestaan uit een 9-tal knoppen ("Push Buttons") waarmee straks Boter, kaas en eieren

kan worden gespeeld, een Stop-knop (om te stoppen), een Undo-knop (die we v oor v an alles en nog wat

kunnen gaan gebruiken; optioneel), en een tekst-v eld ("Label") waarin de status staat, zoals "X is aan de

beurt". Zie hier (of de hoofdstukken hierv oor en hierna) v oor meer informatie. We gebruiken v oorlopig

alleen maar knoppen en één "Label", geheten Tekst .

Noem de 9 spelknoppen bijv oorbeeld Vak11 , Vak12 , ..., Vak33 , en maak de tekst in de knoppen leeg v ia

de "properties". Gebruik "Horizontal Spacers" en "Vertical Spacers", en "Horizontal/Vertical Layout", om

de ruimte goed te v erdelen.

Koppel het clicked() -signaal v an de Stop-knop aan het close() -slot v an de Form. Zie hier v oor meer

informatie. Gebruik Edit->Edit Signals/Slots. Je kunt dan met de linker muisknop op de Stop-knop klikken,

naar de achtergrond v an de "Form" slepen, en daar het juiste slot kiezen; misschien moet je nog een optie

in het windowtje aanv inken om de mogelijkheden zichtbaar te krijgen.

Test de interface met Form->Prev iew, of bij  Tools->Form Editor->Prev iew. Sav e hem geregeld als

(bijv oorbeeld) bke.ui . Als je wat aan de interface wilt wijzigen, moet dat dus hier.

Stap 2

Deze stap is geheel systeem-onafhankelijk.

Haal de C++-file boter.cc op, en zet deze in directory bke . Dit is een compleet C++--programma dat een

beetje Boter, kaas en eieren speelt. Compileer (met een compiler naar keuze, g++  of Dev-C++ ) het maar

eens, en speel er wat mee. Probeer de code enigszins te begrijpen.

Splits de file in boter.h  (met de definitie v an de klasse bke ) en boter.cc  (met de functies). Voeg

bov en en onder in boter.h  enkele regels toe:

   #ifndef BOTER_H

   #define BOTER_H

   ... klasse bke ...

   #endif //BOTER_H

Zo zorg je erv oor dat zaken maar één keer meegecompileerd worden.

Voeg bov enin boter.cc  toe (onder #include <iostream> ): #include "boter.h" . Compileer het

programma opnieuw en speel er weer ev en mee. Hopelijk werkt het nog precies hetzelfde.
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Haal de functie main  uit boter.cc  weg — nu werkt het programma tijdelijk niet meer. Waarschijnlijk

hoev en boter.h  en boter.cc  later niet meer gewijzigd te worden, maar het mag wel.

Stap 3

Nu moeten we de interface en de boter-code nog koppelen: het echte werk. Dit gaat op beide systemen

nagenoeg hetzelfde, met of zonder Qt.

Haal allereerst main.cc op. Deze file hoeft ook niet meer gewijzigd te worden.

Nu komt het. Je hoeft je niet druk te maken om de "control-flow" zoals tot nu toe gebruikelijk. Het wordt

namelijk event-driven: je hoeft slechts aan te gev en wat er moet gebeuren als je op de knoppen klikt. Haal

daartoe bkespel.h en bkespel.cc op, en pas deze twee herhaald aan door functies hierin toe te v oegen en

steeds te wijzigen. Let erop dat v erschillende namen hierin ov ereen moeten komen met de namen zoals

die in Stap 1 zijn gekozen. De executable gaat bijv oorbeeld heten naar de directory. En de "Form" moet als

objectName  (zie properties) BKEForm  hebben.

Als je al deze files hebt (bke.ui , boter.h , boter.cc , main.cc , bkespel.h  en bkespel.cc , alle

in dezelfde directory bke ), geef dan onder Linux achtereenv olgens:

   qmake -project

   qmake

   make

De eerste regel maakt een projectfile bke.pro , daarna maakt qmake  een "makefile", die het hele

compilatie-proces netjes regelt, en die je steeds met make  uitv oert. Hopelijk is er nu een executable bke

ontstaan. Later hoef je trouwens alleen steeds make  te doen, tenzij  je files hebt toegev oegd.

Onder Windows kan dit ook, maar kun je het ook met de knoppen regelen. Eenv oudiger is de file

bke.pro  hier op te halen, dit project in Qt te laden, en dan met de knoppen te compileren. De executable

gaat hier bke.exe  heten.

Het middelste v an de 9 v akjes, Vak22 , doet nu iets. Probeer het te snappen, v erbeter het, en breidt dit uit

naar de andere v akjes. Het spel moet nu goed gespeeld kunnen worden.

Het is wellicht v erstandig — als je dit allemaal werkend wilt krijgen — om een functie te maken die een

coördinatenpaar binnen krijgt, en dan de juiste acties doet. Of eigenlijk was dit v anaf het begin beter

geweest. En een functie printbord ( )  is ook niet gek.

Tot slot: laat de "Undo"-knop het v eld weer leeg maken. Of laat de computer een zet doen v ia de functie

randomzet ( ) .

Als je meer hulp wilt: geef onder Linux assistant & , of kijk onder Windows in de help-files. Wil je
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bijv oorbeeld plaatjes op de knoppen zetten? Doe Vak22->setIcon (QIcon ("iets.jpg")) . Zoek

maar eens naar de functies v an QPushButton 's.

Natuurlijk v alt er v eel meer ov er Qt te v ertellen, maar dat doen we hier niet. Succes!
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Qt Stappen

Het schrijven van zo’n programma gaat in drie stappen:

1. bouw een mooie interface;

2. maak een niet-grafisch goed werkend C++-programma;

3. plak deze twee in elkaar; gebruik make.

Of misschien 1 ←→ 2?
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Qt Boter, kaas en eieren — 1

class bke { // file boter.h

public:

char bord[4][4];

// we gebruiken bord[0][.] en bord[.][0] niet

char beurt;

// wie is aan de beurt: ’O’ of ’X’

bke ( );

bool gewonnen (char & wie);

bool vol ( );

void drukaf ( );

void randomzet ( );

bool magzet (int i, int j);

void doezet (int i, int j);

char wiemoet ( );

void menszet ( );

};//bke
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Qt Boter, kaas en eieren — 2

Als op knop (i, j) van het speelbord geklikt wordt, moet je
een aantal dingen doen:

• controleren of dit mag (vakje vrij?, spel nog niet afge-
lopen?);

• de inhoud (kleur?) van deze knop wijzigen;

• de zet “administreren”;

• tekst updaten;

• wellicht een computerzet doen.

Probleem is vaak dat alle knoppen bijna dezelfde code heb-
ben, maar dat je lastig informatie kunt doorgeven. Oplos-
sing: maak een extra functie probeerzet (i,j) die als het
ware een array “is”.
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Programmeermethoden Tot slot

• werk aan de vierde programmeeropgave — de deadline

is ongeveer nu

• dinsdag 13 en donderdag 15 december 2011: werkcol-

lege met oude tentamens, zalen B1 en B2

• vragenuur over tentamen: dinsdag 3 januari 2012, 11.00

uur, Snellius zaal 174

• tentamen: woensdag 4 januari 2012, 10.00–13.00 uur,

Snellius (hertentamens: 28 maart, 30 juli 2012)
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